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CONCEPTUAL FLOW
Big Idea

Water has identifiable characteristics and the characteristics can be altered and changed in various ways.

) . Flowing water can do work.
Some earth materia.s absorb more water than g

other earth materials. Water contains different
materials that affect its quality.

Properties of water, such as surface tension,
etc., affect the way water behaves on different
surfaces and how water flows down an incline.

Water has its own unique properties . ; ;
que prop Water flows more easily Waterwheels are a kind of machine
powered by flowing water.

through some materials

& than others

Surface tension causes water to stick
together to form a sphere

Liquid water and solid water have
different properties.

Larger amounts of water flow downhill
faster than smaller amounts

Evaporation can be used to detect

Water changes state in processes such SN .
materials dissolved in water.

Water expands when it is heated and contracts as evaporation and condensation.

when it is cooled




UNIT OVERVIEW

Water

Summary
Water is one of Earth’s most important resources and covers three-quarters of Earth’s surface. An appreciation for and
understanding of Earth’s water is important for students as consumers of this critically important resource. The unit Water
explores the properties of water, the cycle and the changes water undergoes as it moves through this cycle as well as the

effects these changes have on Earth.

Enduring Understanding:

Essential Questions: Overarching

Students will understand that.....

e  Water has several observable properties, including
transparency, shapelessness, and movement or flow.

e  Water beads up on some materials and is absorbed by
other materials.

o Surface tension is the skin-like surface of water that
pulls it together into the smallest possible volume.

e Drops of water from domes on pennies because of
surface tension.

e Surface tension can be disrupted by the addition of
some other substances.

e  Water flows downhill.

e Larger amounts of water flow more quickly.

Increasing the slope over which water flows makes it

flow more quickly.

Water expands when heat is added.

Water contracts when heat is taken away.

Warm water is less dense than room-temperature water.

Cold water is denser than room-temperature water.

Cold water is denser than warm water.

A material that floats in water is less dense than the

water; a material that sinks is denser.

e Evaporation is the process by which liquid water
changes into water vapor, a gas.

e Temperature affects the rate of evaporation.

e The surface area of a volume of water affects the rate of
evaporation.

e Condensation occurs when water vapor touches a cool
surface and changes into liquid.

e Evaporation and condensation contribute to the
movement of water through the water cycle.

e Some earth materials, like soils, absorb more water than
other earth materials.

e  Water flows more easily through some earth materials
than through others.
Flowing water can be used to do work.

e  Waterwheels are a kind of machine powered by flowing
water.

e Water contains different materials that affect its quality.

e Evaporation can be used to detect materials dissolved in
water

e  What happens when water gets spilled, splashed, or
dropped on something?

e  Why does water form a dome on flat surfaces?

e How can you change the surface tension of plain water?

e How does changing the slope or quantity of water change
the speed at which it flows downhill?

e What is the best design for a waterwheel that will
efficiently lift objects?

e What are some of the properties of water that affect its
quality?

e  What types of water can be used for different purposes?




Knowledge:

Skills:

Student will Know....

e Water is absorbed by some materials.

e  Water beads up on some materials.

e Surface tension makes a drop of water form beads and
domes with a skin-like surface.

e The speed at which a bead of water flows on a smooth
surface depends on the slope of the surface and the size
of the water bead.

e Water may exist as a solid, liquid or gas, depending on
its temperature.

e Changing the temperature of water may change its
properties.

e Cold water is denser than warm water.

e Liquid water becomes solid water (ice) when it cools to
0o C.

e Warming ice to a temperature above 0oC causes it to
melt into liquid water.

e Evaporation is the process by which liquid water
changes into water vapor.

e Temperature affects the rate of evaporation.

e The surface area of a liquid affects the rate of
evaporation.

e Condensation occurs when water vapor contacts a cool
surface and changes into a liquid.

e Evaporation and condensation contribute to the
movement of water through the water cycle.

e Some earth materials absorb more water than other
earth materials do.

o  Water flows more easily through some earth materials
than through others.

e Flowing water can be used to do work.

e Water contains different materials that affect its quality.

e Evaporation can be used to detect materials that may be
dissolved in water.

Students will be able to...

e Observe the interaction of water with different materials.

e Investigate the property of water surface tension

e Investigate and observe the movement of water on a
slope.

e Use Scientific thinking processes to conduct
investigations and build explanations; observing,
communicating, comparing, and organizing.

e Construct a thermometer to observe that water expands as
it warms and contracts as it cools.

e Observe and describe the interaction between two masses
of water at different temperatures.

e Compare properties of two states of water: solid (ice) and
liquid.

e Investigate the effect of surface area and air temperature
on evaporation.

e Observe condensation.

e Investigate the effect of temperature on condensation.

e Investigate what happens when water is poured through
two earth materials, soil and gravel.

e (Construct a waterwheel and use it to lift objects.

e Compare the properties of local water samples.

Evidence of Understanding:

Diagnostic Assessment: Pre- Assessment

Authentic Assessment: Notebook and Journal Entries
Classwork: FOSS Reading Prompt

Class work/Authentic: Writing Prompts
Participation: Teacher Observation/Anecdotal Notes
Homework: Readorium, extensions, others
Benchmark Assessments: [-Check Assessments

Unit Assessment: Post Test

Assessment Data — Propagated to Genesis

Diagnostic Assessment: Pre- Assessment

Authentic Assessment: Notebook and Journal Entries
Benchmark Assessments: I-Check Assessments

Unit Assessment: Post Test

Preconception /Misconceptions

Water

e When water boils and bubbles, the bubbles are air, oxygen or hydrogen, or heat.

e Steam is hot air
e When steam is no longer visible it becomes air.




Water in an open container is absorbed by the container, disappears, changes into air, or dries up and goes into the air.
Ice molecules are colder than water molecules.

Condensation is when air turns into a liquid.

Condensation on the outside of a container is water that seeped (or sweated) through the walls of the container.
Expansion of matter is due to the expansion of the particles rather than increased space between the particles.

List other that you discover in your class:

Water cycle

The water cycle involves freezing and melting of water.
Water only gets evaporated from the ocean or lakes
The water cycle only includes rain and snow.

That Clouds are made of smoke, pillows, cotton or wool.

Clouds are supernatural events (God, or Angels)

Water is absorbed into surfaces, rather than evaporated into air

When water evaporates it disappears or ceases to exist.

The Sun and Clouds combine to make it rain.

Water come from a tap then you drink it or it disappears down the drain.

List other that you discover in your class:




Standards

New Jersey Common Core Standards

5.1 Science | All students will understand that science is both a body of knowledge and an evidence-based, model-

Practices building enterprise that continually extends, refines, and revises knowledge. The four Science Practices
strands encompass the knowledge and reasoning skills that students must acquire to be proficient in
science.

Strand A Understand Scientific Explanations: Students understand core concepts and principles of science
and use measurement and observation tools to assist in categorizing, representing, and interpreting
the natural and designed world. Who, what, when, where, why, and how questions form the basis for
young learners’ investigations during sensory explorations, experimentation, and focused inquiry

5.1.4.A.1 Fundamental scientific concepts and principles and the links between them are more useful than discrete
facts.

5.1.4.A2 Outcomes of investigations are used to build and refine questions, models, and explanations.

Strand B Generate Scientific Evidence Through Active Investigations: Observations and investigations form
young learners’ understandings of science concepts.

5.1.4.B.2 Tools and technology are used to gather, analyze, and communicate results.

5.14.B.3 Evidence is used to construct and defend arguments

5.1.4.B.4 Reasoning is used to support scientific conclusions.

Stand C Reflect on Scientific Knowledge: Interacting with peers and adults to share questions and
explorations about the natural world builds young learners’ scientific knowledge.

5.14.C.1 Scientific understanding changes over time as new evidence and updated arguments emerge.

5.1.4.C2 Revisions of predictions and explanations occur when new arguments emerge that account more
completely for available evidence.

Strand D Participate Productively in Science: Science practices include drawing or “writing” on observation
clipboards, making rubbings, or charting the growth of plants.

5.1.4.D.1 Science has unique norms for participation. These include adopting a critical stance, demonstrating a
willingness to ask questions and seek help, and developing a sense of trust and skepticism.

5.1.4.D.2 In order to determine which arguments and explanations are most persuasive, communities of learners
work collaboratively to pose, refine, and evaluate questions, investigations, models, and theories (e.g.,
scientific argumentation and representation).

5.1.4.D.3 Instruments of measurement can be used to safely gather accurate information for making scientific
comparisons of objects and events.

5.2 Physical | All students will understand that physical science principles, including fundamental ideas about matter,

Science energy, and motion, are powerful conceptual tools for making sense of phenomena in physical, living, and
Earth systems science.

Strand A All objects and substances in the natural world are composed of matter. Matter has two fundamental
properties: matter takes up space, and matter has inertia.

52.4.A2 Each state of matter has unique properties (e.g., gases can be compressed, while solids and liquids cannot;
the shape of a solid is independent of its container; liquids and gases take the shape of their containers).

5.2.4.A3 Objects and substances have properties, such as weight and volume, that can be measured using
appropriate tools. Unknown substances can sometimes be identified by their properties.

5.4 Earth All students will understand that Earth operates as a set of complex, dynamic, and interconnected systems,

Science and is a part of the all-encompassing system of the universe.

Strand G Biogeochemical Cycles: The biogeochemical cycles in the Earth systems include the flow of microscopic
and macroscopic resources from one reservoir in the hydrosphere, geosphere, atmosphere, or biosphere to
another, are driven by Earth's internal and external sources of energy, and are impacted by human activity..

54.4.G3 Most of Earth’s surface is covered by water. Water circulates through the crust, oceans, and atmosphere in

what is known as the water cycle.




Next Generation Science Standards

Performance Expectations

2-PS1-1 Plan and conduct an investigation to describe and classify kinds of materials by their observable properties.
2-PS1-4 Construct an argument with evidence that some changes caused by heating or cooling can be reversed an some
cannot.

Planning and Carrying Out Investigations: Planning and carrying out investigations to answer questions or test solutions
to problems in K-2 builds on prior expe3rience and progresses to simple investigations, based on fair tests, which provide
data to support explanations or design solutions.

e Plan and conduct an investigation collaboratively to produce data to serve as the basis for evidence, to answer a

question. (2-PS1-1)
Constructing Explanations and Designing solutions in 3-5 builds on K-2 experiences and progresses the use of evidence
and ideas in constructing evidence-based accounts of natural phenomena and designing solutions
* Obtain and combine information from books and other reliable media to explain phenomena.

Engaging in Argument from Evidence Builds on prior knowledge and progresses to comparing ideas and representations
about the natural and designed worlds —Construct an argument with evidence to support a claim (2-PS1-4)
Science Models, Laws, Mechanisms, and Theories Explain Natural Phenomena Scientistws search for cause and effect
relationships to explain natural events (2-PS1-4)

e Different kinds of matter exist and many of them can be either solid or iquid, depending on temperature. Matter
can be described and classified by its observable properties. PS1.A

e Heating or cooling a substance may cause changes that can be observed. Sometimes these changes are reversible,
and sometimes they are not. PS1.B Chemical Reactions 2- PS1-4

Patterns. Patterns in the natural and human designed world can be observed. (2-PS1-1)
Cause and Effect, Events have causes that generate observable patterns (2-PS1-4)




Common Core State Standards

Reading Informational Text

RI.3.10 Ask and answer questions to demonstrate understanding of a text, referring explicitly to the text as the
basis for the answers.

RI3.3 Describe the relationship between a series of historical events, scientific ideas or concepts, or steps in
technical procedures in a text, using language that pertains to time, sequence, and cause/effect.

RI3.9 Compare and contrast the most important points and key details presented in two texts on the same
topic

W.3.1 Write opinion pieces on topics or texts, supporting a point of view with reasons.

W.3.2 Write informative/explanatory texts to examine a topic and convey ideas and information clearly.

SL.3.1 Write informative/explanatory texts to examine a topic and convey ideas and information clearly..

SL.3.2. Determine the main ideas and supporting details of a text read aloud or information presented in diverse
media and formats, including visually, quantitatively, and orally.

SL.3.2 Ask and answer questions about information from a speaker, offering appropriate elaboration and detail

3.MD.B.3 Measurement and data: Draw a scaled picture graph and a scaled bar graph to represent a data set with

several categories. Solve one- and two-step "how many more" and "how many less" problems using
information presented in scaled bar graphs.

Check that all materials are available, usable, and ready

10




Investigation |

Water Observations

Summary
Students investigate the properties of water. They compare the way water interacts with four different surfaces, observe the

property of surface tension, and investigate how to change this property. They compare the rates of different amounts of
water flowing downhill.

Core Conceptual Ideas

» Water is absorbed by some materials
» Water beads up on some materials
» Surface tension makes a drop of water form beads and dome with a skin-like surface.
» The speed at which a bead of water flows on a smooth surface depends on the loped of the surface and the size of the
water bead.
Goals and Objectives

Students ...

New Vocabulary

Water, property, absorb, bead, surface tension, dome, slope, flow
Interdisciplinary Connections

Body of Evidence
Diagnostic Assessment Propagated to Genesis
Survey/Pretest

Pre-Assessment — No Grade
Embedded Assessments I-Check 1

Notebook Entries (minimum of 3)

Student Response Sheets No. 2,

Teacher Observation Assessment Sheet No 1

Benchmark
I-Check 1

11




Part 1 - “Looking at Water”

Summary
Students conduct investigations to observe the properties of water, an important earth material. They compare how water

interacts with four materials, paper towel, waxed paper, aluminum, foil, and writing paper.

Core Ildeas/Understandings S & E Practices CC Concepts

» Water has observable properties, including transparency,
shapelessness, and movement or flow.

» Water beads up on some materials and is absorbed by other
materials

Focus Questions
» What happens when water gets spilled, splashed or dropped on something?
» Does water do the same thing on all surfaces?

Teacher Preparation Body Of Evidence Est. Time

_ 2 Sessions

» Send Letter to Parents Home (Teacher

e Notebook: Investigation 1 Entry 1
Master ) . e Student Sheet: No.2
» Read TE A,:[ A“Glance. ’ Baf:kground for | ¢ FOSS Science Story: A Report from the Blue Planet.pg. 2
the Teacher & ",l:eachlng Children About | Writing Prompt: Respond to Focus Questions
Water Prppertles . e Journal Entry:
> gi[fh Video Demonstration of Inv. 1 e Teacher Observation: Assessment Sheet No. 1
» Review

“ Materials” “Getting Ready”& “Guiding
the Investigation”
» Prepare materials

Homework/Center Activities/Extra Practices

e Rising Readorium (20 min/night), e  Word wall activities
e Spelling City(vocab); e Cross Curriculum Extensions
e FOSS Digital Resources: eBook, Audio Stories e Informational Text —Reading
o  Suggested websites o

Addition Activity

Where does the water from your faucet come from? Where will it go after you use it? Why is it important not to pour
things other than waste water down the drain?

12




Part.2 — Surface Tension

Summary
Students investigate surface tension and its properties.

Understandings
» Surface tension is the skin-like surface of water that pulls it together into the smallest possible volume
> Drops of water form domes on pennies because of surface tension
> Surface tension can be disrupted by the addition of some other substances

Focus Questions
» What shape does water make on a flat surface?
» Why does water forma dome on a flat surface?
» How can you change the surface tension of plain water?

Teacher Preparation Body Of Evidence Est. Time
» Watch Video Demo of Inv.1 Part 2 » Notebook Investigation Entry 3
» Review “Materials” and “Getting Ready” » Reading: FOSS Student text Surface Tension pg. 3 sessions
&“Guiding the Investigation” »  Writing Prompt: Review Questions p.8
» Prepare materials » Journal Entry
» Student Observation/Anecdotal Notes
» Homework
Individual work
» Cross Curriculum Extensions
» Information Text
» 1Check 1 — Step 20
>
Part 3 — Water on a Slope
Students investigate what happens to a drop of water on a slope.
Understandings
» Water flows downhill
» Larger amounts of water flow more quickly
» Increasing the slope over which the water flows makes it flow more quickly
Focus Questions
» What happens to beads of water when they are placed at the top of a slope?
» How does changing the amount of water in a bead change the speed at which water flows downhill?
» How does changing the slope change the speed at which water flows downhill?
Teacher Preparation Body Of Evidence Est. Time
» Read TE “At A Glance”, “Background for » Notebook Investigation Entry
the Teacher” &“Teaching Children About » Reading: FOSS Student text Which Way Does it Go?
Water Properties” pg. 4
» Watch Video Demonstration of Inv. 1 Part 3 » Writing Prompt: Review Questions
» Review “ Materials” “Getting Ready” » Journal Entry
&“Guiding the Investigation” » Student Observation/Anecdotal Notes
» Prepare materials » Homework
Individual work
» Cross Curriculum Extensions
» Information Text
» 1Check 1—Step 12
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Suggested Center Activities: Spelling City; FOSS Digital Resources: eBook, Audio Stories; suggested websites; word wall

activities; extension activities; and additional supporting Science activities.

Culminating Activity: Begin planning with students culminating project. Suggestions: Students create a full inquiry
activity based on one of following topics.1. What materials besides soap can change the surface tension of water? 2. How
much water can a sponge absorb? A wash cloth? 3 How fast does a drop of water travel down a slope? On a steeper slope?
Different sized slope? What units should you use to describe the speed? 4. What happens when you freeze different kinds
of liquids, like milk or juices? Do they expand, contract, or stay the same volume when they freeze? 5. Can you find a way
to make ice sink in water? 6. What happens when you float different objects in salt water? In other liquids> What do your
observations tell you about the density of the objects compared to the liquid? 7. How do different types of thermometers

work? The students can develop hypothesis, procedure, collect data, conclude, and explain.

Investigation 2 “Hot Water, Cold Water”

Summary

Students observe the properties of water as it is heated, cooled, and frozen. They make a water thermometer and find that
water expands as it is heated. Students compare the density of water at different temperatures and find that warm water Is

less dense than cool water, and ice is less dense that liquid water.

Concepts:
Water may exist as a solid, liquid, or gas, depending on its temperature.

Changing the temperature of water may change3 its properties

Cold water is denser than warm water

Liquid water becomes solid water (ice) when it cools to 0°C.

Warming ice to a temperature above 0°C causes it to melt into liquid water.

VVYVYVYYVY

New Vocabulary Investigation 2
Expand, contract, sink, denser, float, less dense

Part 1: Build a Thermometer

Summary

Students construct a thermometer to observe that water expands as it warms and contracts as it cools.

Understandings

» Water expands when heat is added
» Water contracts when heat is taken away

Focus Questions

» What happens to water when it is heated?
» What happens to water when it is cooled?

Teacher Preparation Body Of Evidence Est. Time
» Read TE » Notebook Investigation Entry 2 sessions
“At A Glance”, “Background for the Teacher”’& |» Writing Prompt: Review Questions p. 18
“Teaching Children About Hot and Cold” » Journal Entry
» Watch Video Demonstration of Inv. 2 Partl » Student Observation/Anecdotal Notes
»> Review » Journal Entry
“ Materials” “Getting Ready” &“Guiding the » Homework (Suggestions)
Investigation” » Cross Curriculum Extensions
» Prepare materials » Information Text

14




Part 2 — Sinking and Floating Water

Summary
Students compare properties of two states of water: solid and liquid.

Understandings
» Warm water is less dense than room-temperature water
» Cold water is more dense than room-temperature water. Cold water is denser than warm water
» A material that floats in water is less dense than the water; a material that sinks is more dense

Focus Questions
» Is hot water denser or less dense than room temperature water?
» Is cold water denser or less dense than room temperature water?

Teacher Preparation Body Of Evidence Est. Time

Student Observation/Anecdotal Notes
Homework (Suggestions)

Cross Curriculum Extensions Interdisciplinary
Extensions

» Watch Video Demo of Inv.2 Part 2 » Notebook Investigation Entry 2 sessions
» Review “Materials” and “Getting » Reading: FOSS Student text The Pond pg 5
Ready” » Questions to Explore pg 7 student Foss text
»  Writing Prompt: Review Questions pg. 29, Summary
Prepare materials questions pg 33
» Journal Entry
>
>
>

Part 3 — Water as Ice

Summary
Students compare properties of two states of water: solid and liquid.
Understandings
» Water begins to expand when its temperature reaches 4 degrees C
» Water is densest at 4 degrees C
> lIce is less dense than liquid water
» A solid has definite volume and shape; a liquid has only definite volume
Focus Questions
» What happens to water when it freezes?
» What happens to ice when it is heated?
> How do the masses of equal volumes of ice and water compare?

Teacher Preparation Body Of Evidence Est. Time

» Watch Video Demo of Inv.2 Part 2 Notebook Investigation Entry 3 sessions

» Review “Materials” and “Getting Reading: FOSS Student text Ice is Everywhere
Ready” and Ice History pg. 8& 10

Writing Prompt: Review Questions pg. 29,

Summary questions pg 33

Journal Entry

Student Observation/Anecdotal Notes

Homework (Suggestions)

I Check 2: Step 16

Prepare materials

YVVY YV VY

Suggested Center Activities: Spelling City, Foss suggested websites, word wall activities, extensions, additional
supporting Science Activities,

Culminating Activity: Continue to work on projects.

15




Investigation 3
Water Vapor

Summary
Students are introduced to water vapor and evaporation. They explorde the effects of environmental conditions and

surface area on rates of evaporation. They set up condensation and consider how evaporation and condensation contribute
to the water cycle.

Concepts
Evaporation is the process by which liquid water changes into water vapor.

Temperature affects the rate of evaporation

The surface area of a liquid affects the rate of evaporation

Condensation occur when water vapor contacts a cool surface and changes into a liquid
Evaporation and condensation contribute to the movement of water through the water4 cycle.

VVVYYVY

New Vocabulary Investigation 3
Evaporate, water vapor, seriate, thermometer, surface area, condense, water cycle

Part 1: Evaporations

Summary
Students observe and consider a demonstration in which two paper towels are soaked with equal amounts of wat4r and

then left to evaporate; one in a cup with a lid, and the other in an open cup.

Understandings
» Evaporation is the process by which liquid water changes into water vapor, a gas

Focus Questions
» What happens when two paper towels are allowed to dry, one in a cup with a lid, and the other in an open cup?

Teacher Preparation Body Of Evidence Est. Time

» Read TE » Reading: FOSS Student text Wet and Dry 3 sessions
“At A Glance”, “-Background for the Places pg. 12 2 sessions of 15
Teacher”’&“Teaching Children About Water » Writing Prompt: Review Questions pg. 43 minutes on two
Vapor” » Notebook Investigation Entry consecutive

» Watch Video Demonstration of Inv. 3 Partl » Journal Entry days (or early

» Review » Student Observation/Anecdotal Notes am and end of
“ Materials” “Getting Ready” &*“Guiding the » Homework (Suggestions) day) Part 2 can
Investigation” » Cross Curriculum Extensions be right after

» Prepare materials » Informational Text Reading results read.

Investigation 3: Part 2. Evaporation Locations

Summary
Students investigate the effect of location /air temperature on the rate of evaporation,. They measure equal amounts of

wate4r into four cups, place thde cups in four different locations, and monitor the temperatures at he locations for 4 days.
They measure and compare the amount of water remaining in the cups.

Understandings

Temperature effects the rate of evaporation

Focus Question
What effect does air temperature have on evaporation?

Teacher Preparation Body Of Evidence Est. Time
» Watch Video Demo of Inv.3Part »  Writing: Summary questions pg 50 3 sessions
2 » Notebook Investigation Entry First part 25-30
» Review “Materials” and » Journal Entry min
“Getting Ready” & “Guiding »  Student Observation/Anecdotal Notes 5-18 min in AM
the Investigation” » Homework and afternoon
» Cross Curriculum Extensions to monitor
Prepare Materials evaporation
20-30 Fifth day
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Investigation 3: Part 3. Surface Area

Summary
Students measure equal amounts of water into four containers of different shapes. The surface area of the water is

different in each container, After four days, students measure and compare the amount of water remaining in each
container.,

Understandings
The surface area of a volume of water affects the rate of evaporation

Focus Question
What effect does surface area have on the rate of evaporation?

Teacher Preparation Body Of Evidence Est. Time

»  Watch Video Demo of Inv.3Part 3 » Reading: FOSS Student text Evaporation and 3 sessions
» Review “Materials” and “Getting Condensation? Pg. 13
Ready” & “Guiding the »  Writing: Summary questions pg 50
Investigation” » Notebook Investigation Entry
» Journal Entry
Prepare Materials »  Student Observation/Anecdotal Notes
» Homework
>

Cross Curriculum Extensions

Investigation 3: Part 4. Surface Area

Summary
Students observe cups of ice water and room-temperature water and observe the process of condensation. They set up a

condensation chamber and consider the factors that cause condensation. The water cycle is introduced.

Understandings
» Condensation occurs when water vapor touches a cool surface and changes into a liquid
> Evaporation and condensation contribute to the movement of water through the water cycle

Focus Question
What happens when the surface area of an object or material is cooler than the air surrounding it?

Teacher Preparation Body Of Evidence Est. Time

Cross Curriculum Extensions
I Check 3: After Step 14

» Watch Video Demo of Inv.3Part4 | » Reading: FOSS Student text The Water Cycle? pg. 14 3 sessions
» Review “Materials” and “Getting | » Questions to Explore pg 16 student Foss text
Ready” & “Guiding the » Writing: Summary questions pg 50
Investigation” » Notebook Investigation Entry
» Journal Entry
Prepare Materials »  Student Observation/Anecdotal Notes
» Homework
>
>

Suggested Center Activities: Spelling City, Foss suggested websites, word wall activities, extensions, additional
supporting Science Activities,

Culminating Project: Students work towards completing project.

17



Investigation 4
Waterworks

Summary
.Students compare what happens when water is poured through two different earth materials, soil and gravel. Students

construct a waterwheel and see it to lift objects., learning about the power of water. They collect water from local sources
examine the properties and are introduced to the concept of water quality.

Concepts
Some earth materials absorb more water than other earth materials do.

Water flows more easily through some earth materials than through others
Flowing water can be used to do work

Water contains different materials that affect its quality

Evaporation can be used to detect materials dissolved in water.

VVVYYVY

New Vocabulary Investigation 4
Soak, drain, earth materials, blade, shaft, water quality, dissolve

Part 1:

Summary
.Students pour equal amounts of water through equal masses of two earth materials, soil and gravel. They measure the

amount of water that drains though the earth materials and compare the resulting masses of soil and gravel, using a
balance.

Understandings
» Some earth materials, like soils, absorb more water than other earth materials
» Water flows more easily through some earth materials that through others

Focus Questions
What happens when you pour water through different earth materials?

Teacher Preparation Body Of Evidence Est. Time

» Read TE » Reading: FOSS Student text Water: A Vital 3 sessions

“At A Glance”, “-Background for the Resource pg. 17

Teacher (ground water)”&“Teaching » Questions to Explore pg 21 student Foss text

Children About The Water Works” » Writing Prompt: Review Questions pg. 43
» Watch Video Demonstration of Inv. 4 Partl » Notebook Investigation Entry
» Review » Journal Entry

“ Materials” “Getting Ready” &“Guiding the | » Student Observation/Anecdotal Notes

Investigation” » Homework (Suggestions)
» Prepare materials » Cross Curriculum Extensions

» Informational Text Reading

Investigation 4: Part 2. Waterwheels

Summary
Students design and construct simple waterwheels. They use water to power their water wheels to lift objects. They refine

their designs with each trail and determine how many syringes of water it takes to lift an object a specified distance.

Understandings

» Flowing water can be used to do work
> Waterwheels are a kind of a machine powered by flowing water

Focus Question

» How does a waterwheel work?
> What is the best design for a waterwheel that will efficiently lift objects?

Teacher Preparation Body Of Evidence Est. Time
» Watch Video Demo of Inv.3Part » Notebook Investigation Entry 3 sessions
2 » Reading: FOSS Student text The Power of Water pg.
» Review “Materials” and 22
“Getting Ready” & “Guiding » Writing: Summary questions pg 50
the Investigation” » Journal Entry
»  Student Observation/Anecdotal Notes
Prepare Materials » Homework
» Cross Curriculum Extensions
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Investigation 4: Part 3. Water from Home

Summary
Students observe samples of water collected from their homes and community. They compare samples and evaporate the

water to find out if any contain dissolved materials. They consider the different typOes of water used for different
purposes.

Understanding
> Water contains different materials that affect its quality

> Evaporation can be used to detect materials dissolved in water

Focus Question
What are some of the properties of water that affect its quality?

Teacher Preparation Body Of Evidence Est. Time
» Watch Video Demo of Inv.3Part 3 » Reading: FOSS Student text Ellen Swallow Richards: 3 10-20 min.
» Review “Materials” and “Getting An Early Ecologist pg. 24 sessions
Ready” & “Guiding the »  Writing: Summary questions pg 50
Investigation” » Notebook Investigation Entry
» Journal Entry
Prepare Materials »  Student Observation/Anecdotal Notes
» Homework
>

Cross Curriculum Extensions

I-Check 4: Step 13

Investigation 3: Part 4. Choosing your own investigation

Summary
Students review the properties of water and identify a subject they would like to investigate in greater detail. They present

the results of their projects to the class to share something new about water.

Understandings
> Apply concepts developed concerning water, its properties and its uses

Focus Question
Students ask their own questions and plan investigations or research to answer them.

Teacher Preparation Body Of Evidence Est. Time
Assess students using chart for » Reading: FOSS Student text Moon Dreams? pg. 27 This project is
investigation 4 » Writing: Summary questions pg 50 worked on
» Journal Entry during the
»  Student Observation/Anecdotal Notes length of the
» Homework unit and
» Cross Curriculum Extensions completed at
presented at this
>  Unit Assessment time.

Suggested Center Activities: Spelling City, Foss suggested websites, word wall activities, extensions, additional
supporting Science Activities,

Culminating Project: Students complete project, and present to class

Unit ends . The Unit takes an estimated 37 session and there are sessions scheduled. (3 additional
science days built in)
Session = 45 minutes

Assessments:

The following items are to be tracked by the teacher and recorded in Genesis for administration and parents to view.

Writing prompts
Notebook Investigation Entry
Journal Entries
Student Observations
Anecdotal Notes
Homework
Summative Assessments:
Pre-assessment, I-checks, End of Unit assessments, Post Assessment (data to be tracked)




Body of Evidence

This guide is intended to support the collection of a Body of Evidence. A student’s Body of Evidence should, at a
minimum, include work form the listed prompts and in-class investigations that demonstrate a student’s level of
proficiency. The FOSS pre-assessment given at the beginning of the unit, the I-checks given after each investigation and
Grade 3 DISTRICT Earth Science Benchmark Assessment given at the end of the unit (Post-assessment) may also be
included in the body of evidence.

Writing Prompts Overview

These prompts support the investigations and can be used with their journaling.

Prompt 1: FOSS: Water: Investigation I — Water Observations — Part 1: Looking at Water
1. What happens when water gets spilled, splashed, or dropped on something?
2. Does water do the same thing on all surfaces?

Prompt 2: FOSS Water: Investigation I — Water Observations — Part 2: Surface Tension
1. What shape does water make on a flat surface?
2. Why does water form a dome on flat surfaces?
3. How can you change the surface tension of plain water?

Prompt 3: FOSS: Water: Investigation I — Water Observations — Part 3: Water on a Slope
1. Does water always flow downhill?
2. How does changing the slope or quantity of water change the speed at which it flows downhill?

Prompt 4: FOSS: Water: Investigation 2 —Hot Water, Cold Water — Part 1: Build A Thermometer
1. What happens to water when it is heated?
2. What happens to water when it is cooled?

Prompt 5: FOSS: Water: Investigation 2 —Hot Water, Cold Water — Part 2: Sinking and Floating Water
1. What happens to water when it is heated?
2. What happens to water when it is cooled?

Prompt 6: FOSS: Water: Investigation 2 —Hot Water, Cold Water — Part 3: Water as Ice
1. What happens to water when it freezes?
2. What happens to ice when it is heated?
3. How do the masses of equal volumes of ice and water compare?

Prompt 7: FOSS: : Water: Investigation 3 — Water Vapor — Part 1: Evaporation
1. What happens when two paper towels are allowed to dry, one in a cup with a lid and the other in an
open cup?

Prompt 8: FOSS: : Water: Investigation 3 — Water Vapor — Part 2: Evaporation Locations
1. What effect does air temperature have on evaporation?
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Prompt 9: FOSS: : Water: Investigation 3 — Water Vapor — Part 3: Surface Area
1. What effect does surface area have on the rate of evaporation?

Prompt 10: FOSS: : Water: Investigation 3 — Water Vapor — Part 4: Condensation
1. What happens when the surface of an object or materials is cooler than the air surrounding it?

Prompt 11: FOSS: : Water: Investigation 4 — Waterworks — Part 1: Water in Earth Materials
1. What happens when you pour water through different earth materials?

Prompt 12: FOSS: : Water: Investigation 4 — Waterworks — Part 2: Waterwheels
2. How does a waterwheel work?
3. What is the best design for a waterwheel that will efficiently lift objects?
Prompt 12: FOSS: : Water: Investigation 4 — Waterworks — Part 3: Water from Home
1. What are some of the properties of water that affect its quality?
2. + What types of water can be used for different purposes?
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Materials Sheet

Be aware that the classroom teacher or school site must supply a few items. Here is a summary of supplies not included in

the kit.
Part Description Qty Qty Qty
Number required In kit Need to
order
03-003N Water, Non-consumables XXXX | XXXX XXXX
2064 Bottle, dispensing, plastic 3
2062 Bottle, glass, 60ml 10
1035 Clothespins 20
2067 Cups, filter with holes 20
1010 Cup, plastic, Solo TP9, 90z 50
2063 Cup, plastic, 160z 20
5077 Dropper, plastic with black rubber end 36
2085 Duplication Masters, Water (9) 1
3046A Gravel, aqua, 1 1b. 1
1352 Inventory & Assessment Log, Water 1
1095 Lid, plastic, container, 1/2 liter 20
2065 Lid, plastic, dome 36
2071 Limestone chips, 500g, 1 Ib. 1
4072 Marker, permanent 3
2073 Objects set (2 beads, 2 corks) 1
1455 Pesticide Awareness Extensions, Water 1
2075 Poster, Water cycle, laminated 1
1025 Rubber bands, #14 25
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2077 Rubber stoppers, 1-hole, #1 10
2079 Sponge 8
1027 Stick, popsicle 25
2086 Teacher's Guide, Water 1
1059 Tray, plastic, cafeteria 8
2081 Tray, plastic, ice cube 1
2014 Vial, 12 dram with lid 36
2004 Vial, 7 dram, with caps 20
2083 Vial, soft, 50-ml with caps 20
5082 Video, teacher prep, Water 1
03-003M Water, Measurement Parts XXXX | XXXX XXXX
5055 Balance, equal arm 1
5063 Beaker, 100-ml 8
1062 Container, plastic, 1/2-L 8
5064 Container, 1-L 8
5065 Cylinder, graduated, 50-ml 8
3019 Hand lens, one power 16
5066 Pitcher 2
5067 Spoon, 25-ml 1

Content books-

Unit Resources:

e FOSS Student Book with Unit

e See Reading Extensions in TE

e FOSS Reading Supplemental Books
e  Sun, Moon and Stars Series

FOSS Website:

www.fossweb.com (additional resources and web sites found there)

Spelling City:

www.spellingcity.com

United Streaming Videos



http://www.fossweb.com
http://www.spellingcity.com

http://www.discoveryeducation.com//?ref=streaming&returnUrl=http%3 A%2F%2Fstreaming%2Ediscoveryeducation%?2
Ecom%2Findex%2Ecfm

Brainpop (see if your school has license for this)
http://www.brainpopjr.com/
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